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tells you how to load paper and adjust
your printer software for printing.

{:\g Steps to basic printing HO me pag e

Lexmark™ Z12 Color Jetprinter™ User’s
Guide for Mac OS 8.6 and Mac OS 9

Maintaining your printer o _
_ _ Use this guide when you have questions about your
tells you how to install, replace, and align printer or when you encounter a problem.

the print cartridge.
P J Tips for using this guide

« Use the buttons on the left side of the screen to

Troubleshooting navigate through the chapters of this guide.

' . ' _ o  Click the blue text to link to another part of this
& provides information for solving printing guide.
problems. . Click the left or right
arrows to move forward or )
back through the pages.
_ Click the house to return L o
Appendix to the Home page.
@ provides software installation « Click Edition notice to view edition and trademark

information.
« To print this guide:
1 From the Acrobat Reader File menu, choose Page

instructions and safety information.

Setup....
) Index 2 Select the Landscape orientation button.
provides quick links to the information 3 Click OK.
you need. Just click an index entry, 4 From the Acrobat Reader File menu, choose Print.

and go to the information source. 5 Select the pages you want to print, and then click Print.
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Steps to basic printing

This guide describes how to use your printer with Mac OS 8.6 and
9. For help using your printer with Windows 95 or Windows 98,
refer to the User’'s Guide that came with your printer. For help
using your printer with Windows 2000, refer to the User’'s Guide
button on the printer software CD.

To perform basic printing tasks, follow four simple steps:
Step 1: Insert the appropriate print cartridge

Step 2: Load the paper

Step 3: Customize the printing options

Step 4: Print your document
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Step 1: Insert the appropriate print cartridge

Your printer uses one print cartridge at a time: either a color
cartridge or a black cartridge. Documents that you want to print
ﬁ with colored text or graphics must be printed using a color print

Steps to basic printing

cartridge. To extend the life of your color print cartridge, you can
print black and white documents using a black print cartridge.

Maintaining your printer Your printer came with a color print cartridge (Lexmark part
number 17G0060). You may purchase a black print cartridge
(Lexmark part number 17G0050) from your point of purchase
& retailer or from a Lexmark Authorized Supplies Dealer. You may

also purchase a high yield color cartridge (Lexmark part number
16G0065) or a high yield black cartridge (Lexmark part number

Troubleshooting 16G0055). Where available, you may purchase supplies directly
from Lexmark via the phone or the Lexmark Web site.

Appendix

Index
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Step 2: Load the paper

1 Place the paper against the right side of the sheet feeder, with the

print side facing you.
Paper alignment
marks

4 Sheet feeder

2 Squeeze the release tab and the paper guide together, and slide
the paper guide to the edge of the paper.

Paper guide

Release tab
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Loading specialty paper

Load up to: Make sure:
100 sheets of » The print side is facing you.
plain paper

The paper guide is against the side of
the paper.

10 envelopes

The print side is facing

you.
The stamp location is in r\

the upper left corner.

k/
The envelopes are =

loaded vertically against
the right side of the sheet feeder.

The paper guide is against the side of
the envelopes.
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L Load up to: Make sure:
Steps to basic printing

10 greetingcards, |+ The print side is facing you.

index cards, . .
» The cards are loaded vertically against

ﬁ Eﬁzttgaégfés ' the right side of the sheet feeder.

» The paper guide is against the side of

Maintaining your printer the cards.
25 sheets of » The print side is facing you.
coated paper, . .
& ohoto paper, or | The glossy or coated side is facing you.
glossy paper » The paper guide is against the side of
Troubleshooting the photo paper.
Note: Remove each photo as it exits the
@ printer, and allow it to dry before stacking.
Appendix
7 J
Index
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Load up to: Make sure:
25 iron-on » The print side (black side) is facing you.
transfers

* You follow the instructions on the
packaging to load the iron-on transfers.

» The paper guide is against the side of
the iron-on transfers.

Note: To ensure the

iron-on transfer prints @
correctly, you may want
to print on plain paper 4 © \
before printing on an :@j BN )
iron-on transfer.

8 }
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S Load up to: Make sure:
Steps to basic printing
100 sheets of » The print side is facing you.
custom size . : .
paper » The paper guide is against the side of
ﬁ the paper.
* Your paper size fits within these
Maintaining your printer dimensions:
- Width:
76 mm to 216 mm
(2227 3.0in.t0 8.5in.
- Length:
Troubleshooting 127 mm to 432 mm

5.0in.to 14.0 in.

2

Appendix

Index
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L Load up to: Make sure:
Steps to basic printing

20 sheets of » The print side is facing you.

banner paper
pap * You remove any paper from the sheet

ﬁ feeder, and load the banner paper.
To load the
Maintaining your printer banner paper:

a Pull the paper

support up

& slightly to 1‘
unlock the front t

tabs.

Troubleshooting

b Tilt the

paper

support l

back until it \ i
Appendix Iocks inthe '}

horizontal

position.

10 g

Index A
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Load up to: Make sure:
20 sheets of c Place
banner paper your stack
(cont.) of banner )
paper on 7
the paper / 2
support 4
d Insert the
leading edge \
of the first
pageintothe P
sheet feeder. %
* The paper / &
guide is

against the side of the paper.

 After your banner prints, remove the
banner paper, and return the paper
support to the upright position.

11 )



Cé Steps to basic printing {i\g

Load up to: Make sure:

Steps to basic printing
25 transparencies |+ The rough side of the transparencies is
facing you. If your transparency has a
removable stripe, make sure it is away
ﬁ from you and facing down.

» The paper guide is against the side of

Maintaining your printer ;
the transparencies.

Note: Remove each transparency as it
& exits the printer, and allow it to dry before
stacking.

Troubleshooting

2

Appendix

Index
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Step 3: Customize the printing options

Your printer software works with your operating system to help
you print documents with superior results. To customize your
printing options, use the Page Setup dialog box and the Print

dialog box.

Click Help
Lexmark Z12 Page Setup to access
the printer
= driver help.
—[ General ¥ |
Paper Size: [ .S, Letter \i
@ Click this
Scaling (%): 188 pop-up menu
to selec_t a
Orientation: | T@ paper size.
Limensions: 8.50 by 11.00 H’-J
Click one of
—— | thesetoselect
the page
[_Cancel | orientation.
13 g

Qg
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Page Setup
Steps to basic printing
From the pop-up

menu, choose: Select: When you want to:
General Paper Size * View the available paper
sizes.
Maintaining your printer Scaling * Change the scaling value

of the document. Valid
values are between 25%

& and 400%.

Orientation * Choose between portrait

. and landscape.
Troubleshooting

Watermark Watermarks ¢ Choose the watermark
you want.
Appendix
14 )
Index
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Steps to basic printing

Click Help to access the printer

driver help.
ﬁ Clickthis Lexmark 212 Print B0
pop-up [ Help |
Help
. . menu to \( General i]
Maintaining your printer select
print
settings. Copies: EI

& Pages: 3 ANl
i3 From: I:I To: I:I

Troubleshooting (1 Print Last Page First
This area I Wait for pages to dry
displaysa Print Quality: Normal Faper Type: Flain Print In: Background
summary { ; : :
@ of the L= Image : Color ColorSync : Off Watermark : Off
current

ttings.
Appendix SeTngs [ Save Settings ][ Revert to Defaults ] [ Cancel ]|Pr|nt|

15
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Print

Steps to basic printing
From the pop-up

menu, choose: Select: When you want to:
ﬁ General Copies * Type in the number of
copies (1-999).
Maintaining your printer Pages * Print all pages or a given
page range.
Print Last * Printthe pagesinreverse

& Page First order.

Wait for pages |+ Add more time between
Troubleshooting to dry pages as they exit the

printer.

Appendix

16
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From the pop-up

Steps to basic printing menu, choose: Select: When you want to:
Paper Paper Type » Select Plain Paper,
Type/Quality Coated Paper,
ﬁ Glossy/Photo Paper,

Transparency, or lron-On
Maintaining your printer Transfer.

Print Quality » Select Quick Print (600
dpi), Normal (600 dpi), or

& High (1200 dpi).

Color ColorSync » Select a printer profile to
Troubleshooting Color match the color on the
Matching screen to the color in the
document.
@ Built-in Color |« Let the printer driver
Matching match the color on the
Appendix screen to the color in the
document.
J
17

Index 4&! 1Yy
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From the pop-up

Steps to basic printing menu, choose: Select: When you want to:
Background Print in * Print quickly.
Printin Foreground
ﬁ g g Note: Do not use your
system while the document
o . is printing.
Maintaining your printer
Print in * Print most documents.
Background
& J + Select an exact date and
time for the document to
print.

Troubleshooting
* Mark a print job as
Urgent.

@ * Put a print job on hold.

Note: You may use your
system while the document
is printing.

Appendix

18

Index 4 1y
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Changing the page settings

Steps to basic printin . . . .
: o To change the paper size, orientation, scaling, and watermark

settings:
ﬁ 1 From the File menu, choose Page Setup.
The Page Setup dialog box opens.
Maintaining your printer 2 Change the settings as needed.
3 Select OK.
& Changing the print settings from an application
To change the print settings from an application (for example,
Troubleshooting word processing, spreadsheet, graphics, and so on):

1 Open the application’s File menu.
@ 2 Choose Print....
The Print dialog box opens.
3 Change the settings as needed.

Appendix 4 Select Save Settings.

19
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Changing the print settings from the desktop
To change the print settings from the desktop:

From the desktop, open the File menu.
Choose Print....
The Print dialog box opens.

Change the settings as needed.
Select Save Settings.

20



Cé Steps to basic printing {'\\2

Changing the printing options for specialty paper
When you installed the printer software, the Page Setup dialog

box and the Print dialog box were set to the default settings. Use
ﬁ these default settings for printing most documents on plain paper.

Steps to basic printing

To change the print settings for printing on specialty paper, use
the following table:

Maintaining your printer When you are Open this

printing on: dialog box: |To make these selections:

menu, select the appropriate
envelope size.

& Envelopes Page Setup |« From the Paper Size pop-up

Troubleshooting Note: Many applications are

designed to override the
envelope settings in Page Setup.

@ Make sure landscape orientation
is selected in your application.

Appendix Greetingcards, |Page Setup |« From the Paper Size pop-up
index cards, or menu, select the appropriate
21

postcards card size.
Index 4&! 1Yy
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L When you are Open this
Steps to basic printing

printing on: dialog box: |To make these selections:

Photo or glossy |Print 1 On the Paper Type/Quality

paper pane, select Glossy/Photo
ﬁ Paper for the Paper Type.

2 Select High (1200 dpi) for the

Maintaining your printer Print Quality.

3 On the Color pane, select Built-

& In Color Matching.

4 From the Document Color pop-
Troubleshooting up menu, select Natural Color.

Note: Remove each photo as it
exits the printer, and allow it to dry
@ before stacking.

Note: You may want to print on
Appendix plain paper before printing on

photo or glossy paper.

Index

22
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Steps to

When you are
printing on:

Open this
dialog box:

basic printing {'\\2

To make these selections:

Coated paper

Print

* On the Paper Type/Quality
pane, select Coated for the
Paper Type.

Sheets of
custom size
paper

Page Setup

From the Paper Size pop-up
menu, select Edit Custom
Paper Sizes, and enter the
dimensions for your custom
paper size.

Iron-On
transfers

Print

23

* On the Paper Type/Quality
pane, select Iron-On Transfer
for the Paper Type.

Note: To ensure the iron-on
transfer prints correctly, you may
want to print on plain paper
before printing on an iron-on
transfer.
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L When you are Open this
Steps to basic printing printing on: dialog box: |To make these selections:

Banner paper Page Setup |+ From the Paper Size pop-up
menu, select Banner (Letter) or
ﬁ Banner (A4).

Transparencies |Print * On the Paper Type/Quality
pane, select Transparency for
the Paper Type and Normal
(600 dpi) for the Print Quality.

Maintaining your printer

& Note: Remove each

transparency as it exits the
Troubleshooting printer, and allow it to dry before

stacking.
Note: You may want to print on

@ plain paper before printing on a
transparency.

Appendix

24
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Step 4: Print your document

1 Open the File menu.
2 Choose Print....
ﬁ The Print dialog box opens.

3 Select Print.

Steps to basic printing

Maintaining your printer

(S

Troubleshooting

0

Appendix
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Maintaining your printer

This section describes how to install, replace, and care for your
print cartridge. You can use your printer’s Control Panel to help
you with these tasks.

Using the Control Panel
Installing or replacing a print cartridge
Improving print quality
Aligning the print cartridge
Cleaning the print nozzles
Wiping print nozzles and contacts

Preserving print cartridges

26 )
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Maintaining your printer @

Using the Control Panel

The Control Panel lets you monitor your printer’s status, perform
cartridge installation and maintenance, set printer options, and
access driver version and copyright information. To open the
Control Panel, choose:

1 The Apple menu
2 Control Panels
3 Lexmark Z12 Control Panel

J;'vlu
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Cartridges tab to:

« Install or change the print cartridge.

« Align the print cartridge for best print quality.

« Clean the print nozzles. Help button to access
printer driver help.

* Print a test page.
ﬁ — = |
=]

Click the...
Steps to basic printing

[] =—————"Lexmark 212 Control Panel
\/
Maintaining your printer ftartridgevs\lﬂhuut\ @
About tab to L Ink Level
find printer
& SOftV.vare l Install /Change Cartridge... ]
version and
copyright Full
Troubleshooting | information. l Align Cartridges.. ]
Livw
l Clean Print Nozzles ]
@ PAW17G0060
l e T—y— ] Standard Color
Appendix
28 )
Index

Q& ol
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Installing or replacing a print cartridge
1 Make sure the Power light is on.
Power light

Steps to basic printing

g

Maintaining your printer

Paper Feed light

2 Raise the front cover. The print cartridge carrier moves to the
loading position unless the printer is busy.

& Front cover

Troubleshooting \
. . I ‘
@ Print cartridge

carrier in the
loading position

Appendix

Index

Q& ol
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3 Remove the old print cartridge. Store it in the print cartridge

Steps to basic printing storage unit (see page 42) or dispose of it.
Standard Black Cartridge 17G0050
ﬁ Standard Color Cartridge 17G0060
Maintaining your printer High Yield Black Cartridge 16G0055 T
High Yield Color Cartridge 16G0065 @ @

(S

Troubleshooting

2

Appendix

Index
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4 Install the replacement cartridge.
Steps to basic printing

Warning: alfyou are installing anew b Insert the print C Push back
Do NOT cartridge, remove the cartridge into firmly onthe
sticker and transparent the print cartridge until it
touch the gold tape on the bottom of the cartridge carrier. snaps securely
contact area print cartridge. into place.
of the print
Maintaining your printer cartridge.

]
LS - & @

Troubleshooting

2

Appendix
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Close the front cover.

Open the Control Panel.

From the Cartridge tab, select Install/Change Cartridge.
Select the type of cartridge you installed and click OK.

00 N O O
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Steps to basic printing Cartridge Setup

Open the printer front cover and replace the print
cartridge. Please verify the settings below, then

click OK.
a Select the

cartridge you

Maintaining your printer installed. \ Cartridge oo oo

i Color 1760060
() Color 16G00AS

| () Black 17650050
& b Specify | O Black 1660055

whether the
cartridge is a
Troubleshooting New Cartridge
oran Old
Cartridge (one
that has been

@ used before).

i {0 Mew Cartridge
C ClickOK. ~ ——— | _
Appendix T i) 0ld Cartridge

Cancel | m

32 J

Q& g
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9 Ifyou installed a new cartridge, select Yes to align the cartridge.
Steps to basic printing

Align CMY Cartridge

To obtain the highest quality fram your printer, the

cartridges must be aligned. Using the printed test
page, select the number for the pattern that comes
closest to farming a straight line.

Maintaining your printer

(S s
Cancel I I

Troubleshooting

Follow the instructions on the alignment screen to complete the

@ cartridge installation. For help, see page 35.
Appendix
33 )
Index

Q& ol
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10 To see how the cartridge prints, select Print Test Page.
Steps to basic printing

[ ==———————— Lezmark 212 Control Panel ="——————HH
I,i _/EartridgesVHhuut\
Ink Level
Maintaining your printer
[ Inztall /Change Cartridge... ]
Full
[ &lign Cartridges... ]
& SelectPrint L
Test Page . o
: [ Clean Print Mozzles ]
Troubleshooting P/M17G0060
[ Print Test Page ] Standard Color
Appendix
34 )
Index

Q& ol
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Improving print quality

A W DN PP

If print quality is not as high as you expected, you may need to
align the print cartridge or clean the print nozzles.

Aligning the print cartridge

Normally, you only align the print
cartridge after installing a new print
cartridge. However, you may also
need to align the print cartridge
when:

» Characters are not aligned correctly at the left margin.
» \Vertical lines appear “wavy.”

To align the print cartridge:

Load plain paper in the printer.

Open the Control Panel. For help, see page 27.

Click the Cartridge tab.

Click Align Cartridge. Your printer prints an alignment test page,
and the Align Cartridge dialog box appears.

35 )

Q& ol
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An alignment
test page with
30 alignment

patterns prints.

Each pattern
has a number
under it.

Maintaining your printer

The test page looks similar to the one shown:

4,

0123456789 1011121\ 516171815/)21222324252627

AL

15 16 17 18

=

For example, in
alignment group A,
16 comes closest to
forming a straight
line.

5 Find the number under the alignment pattern that comes closest

6

to forming a straight line.

In the Align Cartridge dialog box, enter the pattern number from
the printed test page that comes closest to forming a straight line,
and then click OK.

36 )
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Cleaning the print nozzles

The print cartridge nozzle cleans the print cartridge by forcing ink
through the nozzles to clear any clogged nozzles. A testline prints
S0 you can see if the cleaning process was successful. Run the
nozzle test when:

» Characters are not printing completely.

* White dashes appear in graphics or printed text.
* Printis smudged or too dark.

» Colors do not print correctly.

To run the nozzle test:

1 Load plain paper in the printer.
2 Open the Control Panel. For help, see page 27.
3 Click the Cartridge tab.

Q& ol
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4 Click Clean Print Nozzles.
Steps to basic printing The printer feeds a sheet of paper and prints a nozzle test pattern

similar to the one shown:
Purge lines print

Maintaining your printer when ink is forced
through the nozzles
to unclog them.

[TIFHHHHHLL
i

Troubleshooting

2

Appendix Black cartridge 1 purge line

38

Index .

Broken lines at the top
of the page indicate
clogged nozzles.

Unbroken lines at the
bottom of the page
indicate the nozzles
were cleaned.

When you install a: These purge lines print:

Color cartridge 3 purge lines
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5 Compare the diagonal lines above the printed bars to the diagonal
Steps to basic printing lines below the printed bars. Look for a break in the lines. A
broken line indicates clogged nozzles.

If the bottom line still has breaks, run the test two more times.
ﬁ « If the print quality is satisfactory after running the test three

times, the print nozzles are clean. You do not need to
complete the remaining steps.

* If the print quality of both sets of lines is not satisfactory after
running the test three times, continue with the next step.
& 6 Remove and reinstall the print cartridge.
7 Repeat the nozzle test.

8 If the lines are still broken, continue with the next section, Wiping
print nozzles and contacts.

Maintaining your printer

Troubleshooting

2

Appendix

Index

Q& ol
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Wiping print nozzles and contacts

If print quality does not improve after cleaning the print nozzles
(see page 37), there may be dried ink on the print nozzles or

Steps to basic printing

contacts.
ﬁ 1 Remove the print cartridge from the printer. For help, see page 29.

2 Dampen a clean, lint-free cloth with water. Gently wipe the
nozzles and contacts in one direction.

o > JGoniace

\ 3

Maintaining your printer

(S

Troubleshooting

a Hold the damp cloth b Use another clean section of cloth to
against the nozzles for gently wipe the contacts. Hold the
about three seconds. damp, lint-free cloth against the
Gently blot and wipe dry. contacts for about three seconds.

Appendix Gently blot and wipe dry.

3 Reinstall the print cartridge and repeat the nozzle test. For help,
@ see page 37.

Index
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Preserving print cartridges

To ensure the longest life from your print cartridge and optimum
performance from your printer:

* Keep a new print cartridge in its packaging until you are ready
to install it.

* Do not remove a print cartridge from the printer except to
replace, clean, or store it in the cartridge storage unit or other
air-tight container. The print cartridge will not print correctly if
removed from the printer and left exposed for an extended
period of time.

Lexmark’s printer warranty does not cover repair of failures or
damage caused by a refilled cartridge. Lexmark does not
recommend use of refilled cartridges. Refilling cartridges can
affect print quality and cause damage to the printer. For best
results, use Lexmark supplies.

41
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Storing an extra print cartridge
Steps to basic printing

1 Insert the tabs of the

cartridge storage unit
into the slots on the

back of your printer.
Maintaining your printer

{ 3 Insert the extra print

Troubleshooting (s:tac::gggim:o the ﬁ

2 Snap the storage unit
securely into place.

4 Push back firmly on the ;
cartridge until it snaps /L
into place.
Appendix
42 )
Index
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Removing a print cartridge from the storage unit
Steps to basic printing

1 Pull the print cartridge

handle toward you until you
hear a snap.

Maintaining your printer 2 Pull the print cartridge O
straight out of the storage

unit.

(S

Troubleshooting

2

Appendix
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Troubleshooting

This section lists printing problems that can occur and explains
what you can do to solve them.

From the following list of printing problems, select a category that
describes the type of problem you are experiencing. Then
search for the solution to your problem.

General printing problems

Printer doesn’t print or prints slowly

Paper misfeeds or jams

Document prints with mistakes or poor quality
Problems with transparencies, photos, or envelopes

Error messages and flashing lights
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General printing problems
When there is a problem, first make sure:

The power supply is plugged into the printer and a properly
grounded electrical outlet.

The printer is turned on.

The USB cable is securely attached to both the computer and
the printer.

The printer is set as the default printer. To check the printer
status:

1 Double-click the Lexmark Z12 printer icon on your desktop.
2 From the menu bar, choose Printing.
3 Make sure Set Default Printer is checked.
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Printer doesn’t print or prints slowly

If your printer doesn’t print, your printer and your computer may
not be able to communicate properly. The following events
indicate bidirectional communication problems:

* A message appears on your computer screen indicating that
your printer cannot establish bidirectional communication with
your computer.

» Print cartridge ink level indicators on the Cartridge tab of the
printer’s Control Panel are shaded.

» Error messages (such as Paper Out) and job progress
information do not appear on the computer screen.

Before proceeding, verify that:

» The printer software has been installed correctly. See page 57.

* The USB cable is securely attached to both the printer and the
computer.

» The printer is plugged into an outlet and is turned on.

* Remove any extra devices, such as a scanner or hub, and
connect the printer directly to the USB port.
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Printer is plugged in but doesn’t print
Make sure:

* The printer is turned on.
» Paper is loaded correctly.
» The USB cable is completely plugged into the printer.

» The printer is set as the default printer. To check the printer
status:
1 Double-click the Lexmark Z12 printer icon on your desktop.
2 From the menu bar, choose Printing.
3 Make sure Set Default Printer is checked.

» The print job is not being held in the print queue. To check the
printer status:
1 From the desktop, double-click the Lexmark Z12 icon.
2 From the menu bar, choose Printing.
3 Choose Start Print Queue.

Print a test page. If the test page prints, the printer is functioning
properly. If the printer still doesn’t print, check your application.
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Warning: Do
NOT touch the
gold contact
area of the
print cartridge.

Troubleshooting [§

Test page does not print
Make sure:

» The print cartridge is properly installed. For help, see page 29.

* The Lexmark Z12 printer is set as the default printer. For help,
see page 44.

Printer ejects a blank page after appearing to print
Make sure:

* The Lexmark Z12 printer is set as the default printer. For help,
see page 44.

* You have removed the sticker and transparent tape from the
bottom of the print cartridge. For help, see page 29.

Printer prints very slowly
» Close any open applications not in use.

» Check the document you are printing. Photos and graphics
may take longer to print than regular text.

» Decrease the Print Quality setting to Normal (600 dpi) or Quick
Print (600 dpi).
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» Check your computer’s resources, and consider increasing the
Steps to basic printing virtual memory for your computer.

» Consider purchasing more Random Access Memory (RAM).

ﬁ Paper misfeeds or jams
Paper misfeeds or multiple sheets feed through the printer

Maintaining your printer
gyourp Make sure:

* The paper is recommended for inkjet printers.

& * You do not load too much paper in the sheet feeder. Depending
on the thickness of your paper, the sheet feeder can hold up to
100 sheets of paper.

* You do not force the paper down into the printer when you load
it. Align the top edge of the paper with the paper alignment
marks on the paper support.

Troubleshooting

@ * The left paper guide is against the side of the paper.
» The paper guide does not cause the paper to bow in the sheet
Appendix feeder.

» The printer is on a flat, level surface.

Index
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Printer does not feed envelopes or specialty papers

» Make sure your printer will feed regular paper. For help loading
paper, see page 5.

ﬁ  If regular paper feeds without problems, load the envelopes

Steps to basic printing

vertically against the right side of the sheet feeder. Make sure
the paper guide is against the side of the envelopes. For help
loading envelopes, see page 6.

» Make sure the appropriate envelope size or specialty paper is
selected in the printer software.

& » Make sure you are using a specialty paper or envelope size that
is supported by your printer.

* Your application may not be designed to print envelopes. For
help, check your application’s documentation.

Maintaining your printer
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Printer has a paper jam

Steps to basic printi . . .
SPELILEES L If the paper is lodged too far into the printer and can’'t be

removed:
ﬁ 1 Press the Power button to turn the printer off.

2 Press the Power button to turn the printer back on.

o . 3 If the printer does not eject the page, turn the printer off.
Maintaining your printer i )

4 Pullfirmly on the paper to remove it. If you cannot reach the paper
because it is too far into the printer, raise the front cover and pull
the paper out of the printer.

& 5 Close the front cover.

6 Press the Power button to turn the printer on.
Troubleshooting 7 Resend your document to print.
Document prints with mistakes or poor quality
@ Print is too dark or smudged
ﬂ » Make sure the paper is straight and unwrinkled.
A i — . .
ppendix — » Let the ink dry before handling the paper.
» Make sure the Paper Type setting in the printer software
@ matches the type of paper loaded in the printer.
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* Change the Print Quality setting to Quick Print. For help, see
page 19.

* Clean the print nozzles. For help, see page 37.

Vertical straight lines are not smooth

To improve the print quality of vertical straight lines in tables,
borders, and graphs:

» Select a higher Print Quality setting.
 Align the print cartridge. For help, see page 35.
» Clean the print nozzles. For help, see page 37.

Print smears on the page

* The next page exiting the printer may be smearing the ink.
Remove the pages as they exit the printer and allow them to dry
before stacking.

» The print nozzles may need cleaning. For help, see page 37.
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Printed pages have alternating bands of light and dark print
(intermittent printing)

» Change the Print Quality setting to High Quality. For help, see
page 19.

» Make sure bidirectional communication exists between your
printer and computer. For help, see page 46.
Print quality is poor at the left, right, top, or bottom edge of page

Like other printers, your printer cannot print on the extreme left,
right, top, or bottom edges of a page.

Use these minimum settings:

» Left and right margins:
6.35 mm (0.25 in.) each for all paper sizes except A4

For A4 size paper - 3.37 mm (0.133 in.) each

» Top and bottom margins:
Top - 1.7 mm (0.067 in.)

Bottom - 12.7 mm (0.5 in.) for most jobs
19 mm (0.75 in.) for best print quality for color jobs
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Printed characters are improperly formed or misaligned
» Cancel any print jobs and resend your job to print.

» Align the print cartridge. For help, see page 35.

* Clean the print nozzles. For help, see page 37.

Colors on the printout differ from the colors on the screen

* A print cartridge may be out of ink or low on ink. For help
changing the print cartridge, see page 29.

» Use a different brand of paper. Every paper brand accepts ink
differently and prints with slight color variations.

* Remove any extra devices, such as a scanner or hub, and
connect the printer directly to the USB port.
Colors on the printout are faded

Try the suggestions listed in the previous section, Colors on the
printout differ from the colors on the screen. If your colors still
seem faded, clean the print nozzles. For help, see page 37.
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Characters are missing or unexpected

* Make sure your Lexmark Z12 printer driver is selected as the
default printer.

* Your printer may have bidirectional communication problems.
For help, see page 46.

Problems with transparencies, photos, or envelopes

Glossy photo papers or transparencies stick together

* Remove each page as it exits the printer and allow it to dry
before stacking.

» Use a photo paper or transparency designed for use with an
inkjet printer.
Transparencies or photos contain white lines

* From the Print Quality area, select High Quality. For help, see
page 19.

» Clean the print nozzles. For help, see page 37.

Printer does not feed envelopes or specialty papers
For help, see page 50.
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Error messages and flashing lights
Paper Jam message
For help, see page 51.

Steps to basic printing

O ]2
& oC
Ink Low message
Power Paper . . . . . .
light  Feed A print cartridge is running out of ink. Purchase a new print

Maintaining your printer light cartridge

The Power light is on and the Paper Feed light is blinking

& * If the printer is out of paper:

1 Load paper.
Troubleshooting 2 Press the Paper Feed button.

* If the printer has a paper jam, see page 51.

@ The Power light and Paper Feed light are blinking
The print cartridge carrier has stalled. Check your screen for any

: error messages.
Appendix

1 Turn the printer off.
2 Wait a few seconds, and turn the printer back on.
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This section contains information
about:

¢ Installing printer software

¢ Uninstalling printer software

« Power supply

« Safety

Installing printer
software

You can obtain the printer software
using the:

¢ Compact disc (CD) that came
with your printer
* World Wide Web

If your printer software does not
install properly, a communications
error message appears when you
try to print. You may need to
uninstall and then reinstall the
printer software. For help, see
page 58.

Using the CD
1 Start Mac OS.

2 When the desktop appears,
insert the software CD.
The Lexmark Z12 software
installation screen appears.

3 Click Install and Agree.
4 Click Install.

5 Select the Lexmark Z12 printer
in the Chooser by following the
steps on the dialog box.

Note: If your Macintosh computer
locks up while printing, you may
need to turn off the printer and the
computer, and then turn them back
on. When you turn them back on,
the printer driver’'s spooler may
attempt to start printing the job that
was in the queue before the
computer locked up. This could
cause your system to lock up
again.
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To recover from this problem:

1 Turn off the printer and the
computer.

2 Hold down the Shift key and turn
the computer on.

3 Continue to hold the Shift key
until you see the Mac OS
screen and the words
Extensions Off.

4 Release the Shift key.

5 Locate the Lexmark Z12 printer
icon on your desktop. The
inactive printer spooler has an X
over it.

6 Double-click the icon to open
the Lexmark Z12 dialog box.

7 Drag your print jobs to the trash
can.

8 Restart the computer to enable
the extensions.
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Using the World Wide Web

If your computer does not have a
CD-ROM drive, you can download
the printer software from the World
Wide Web at www.lexmark.com.

Note: Before you begin, make sure
Stuffit Expander is loaded on your
system.

1 From Lexmark’s Web site, select
the appropriate driver for your
operating system.

2 Double-click the binhex (.hgx)
file to open it.

3 Follow the instructions on your
screen.

Uninstalling printer
software
If your printer software does not

install properly, you may need to
uninstall and then reinstall it.

To uninstall the printer software:

1 Drag the printericon to the trash
can on the desktop.

2 Insert the software CD.
The Lexmark Z12 software
installation screen appears.

3 Click Install and Agree.

4 From the Easy Install pop-up
menu, choose Uninstall.

5 Select Complete Uninstall.
6 Click Uninstall.

To reinstall the printer software,
follow the appropriate set of
instructions from “Installing printer
software” on page 57.

Power supply

If your power supply fails, replace it
with the Lexmark replacement part
or other UL LISTED Direct Plug-In
Power Unit marked “Class 2" and
rated 30 V dc at 500mA.
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Safety

If your product is NOT marked

with this symbol [O], it MUST be
connected to an electrical outlet
that is properly grounded.

The power cord must be
connected to an electrical outlet
that is near the product and
easily accessible.

Refer service or repairs, other
than those described in the
operating instructions, to a
professional service person.
This product is designed, tested
and approved to meet strict
global safety standards with the
use of specific Lexmark
components. The safety
features of some parts may not
always be obvious. Lexmark is
not responsible for the use of
other replacement parts.
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